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OPNET IT Guru 11.0
Release Notes
These release notes give an overview of the differences between OPNET IT Guru Release 11.0 and the 
previous release. If you are upgrading from a previous release, you should review this document.

Because release notes are sometimes updated after the product documentation is distributed, visit the 
OPNET website (www.opnet.com/support) often to check for the newest version of these release notes 
and previous release notes.
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Release 11.0 Description

OPNET IT Guru 11.0 is a significant software update to the OPNET 10.5 
software release. This release contains many new features and enhancements 
to existing capabilities. This release also implements suggestions and fixes 
many software problems reported in earlier releases.

System Requirements

Be sure to check the latest system requirements on the OPNET website:

www.opnet.com/support

Changes to Supported Platforms and Products

OPNET 11.0 is supported on the following platforms:

• Solaris—only Solaris 8 and Solaris 9 are supported. Solaris 7 is no longer 
supported.

• Windows—The supported Windows operating systems for the OPNET 
products remain as follows: Windows NT 4.0 Professional, Windows 2000 
Professional, Windows 2000 Server, Windows 2003 Server, Windows 2003 
Advanced Server, and Windows XP Professional.

Licensing Changes

Release 11.0 uses a new format for license files. Because of this, your existing 
license files need to be converted before the OPNET 11.0 license server can 
use them. After installing the 11.0 software, you must convert your license files 
by doing Procedure 11.0-1.

Note the following considerations:

• Until the license file is converted, the 11.0 license server will be unable to 
provide licenses to any 11.0 clients. (However, it can provide licenses to 
pre-11.0 clients.)

• After the license file is converted, 11.0 license servers will be able to serve 
licenses to both 11.0 and older license clients.

Procedure 11.0-1   Converting Pre-11.0 License Files

1 Start the 11.0 License Manager (as in Starting the License Manager on 
page AG-3-7).
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2 In the License Manager tree view, select the server whose license file you want to 
convert. Servers with unconverted license files are marked by a yellow dot with a 
C, as shown in the following figure.

3 Click the Convert Pre-11.0 License File button and follow the on-screen prompts.

Note—More detailed instructions on how to convert a license file are posted at the 
OPNET Support Center (www.opnet.com/support); follow the License Registration 
link to the Instructions section.

End of Procedure 11.0-1

Loanable Licenses

The basic loanable license system built into the OPNET license server now 
supports loan authorization. Using a loan authorization file, license 
administrators can specify which licenses can be loaned by a server and which 
users are allowed to borrow them. For details, see Restricting Loanable 
Licenses on page AG-4-13 of the Administrator Guide.

PL3 Changes

The following sections describe changes to IT Guru that were introduced in 
release 11.0 PL3.

ACE Module Enhancements

User Interface Enhancements

Unified Window for Treeview, Data Exchange Charts, and Tier Pair Circle

The ACE graphical interface now uses a tabbed interface so that the Treeview, 
Data Exchange Chart, and Tier Pair Circle now appear in the same window 
(instead of appearing in separate windows, as in previous releases).

Embedded Protocol Decodes Viewer

You can now choose to embed the Protocol Decode Viewer in the ACE window 
(instead of showing the Viewer in a separate window, as in previous releases). 
Choose View > Embed Protocol Decode Viewer to turn this option on or off. 
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AppDoctor “Drill-Down” Windows

The AppDoctor Summary of Delays window now includes “drill-down” windows 
that enable you to view graphical analyses of specific types of delay (such as 
Protocol/Congestion). For more information, see AppDoctor Drill-Downs: 
Examining the Cause of Delay on page ACE-12-3.

Filtering Enhancements

Filtering Broadcast/Multicast Traffic

The Default filter used by ACE is now set to filter out broadcast and multicast 
traffic. In addition, the Capture File Filter dialog box now has a checkbox for 
filtering out broadcast/multicast traffic. 

Multicast and broadcast traffic is filtered out when the Default packet filter is 
selected in the following situations:

• When you capture traffic using the ACE capture agents

• When you import capture files into ACE

Loading and Saving Filters

When you load or save a capture-file filter, ACE now shows all available filters 
in all model directories. This enables you to save and browse filters in different 
directories.

Capturing Traffic Using NetScout Probes

If you have NetScout probes installed on your local computer, you can use them 
as capture agents in an ACE capture operation. Capturing with Netscout probes 
can be useful in situations where capturing with ACE agents is impractical. 
Examples of these types of situations include:

• When you cannot install an agent on a specific machine due to administrative 
privileges

• Capturing at a high-speed connection, when you are concerned about 
capturing every packet

• Capturing in a switched network that uses Spanning Tree Protocol

For more information, see Capturing Traffic Using NetScout Probes on 
page ACE-4-31 of the ACE User Guide. 

3DNV Module Enhancements

IT Guru 11.0 PL3 includes a new version of the 3DNV module. This version, 
3DNV 1.5.0, includes a number of enhancements to the 3D Network Visualizer 
and 3D Logger programs.
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Because of a change in the format of decoration and layer information that is 
sent from IT Guru to 3DNV, you should be aware of the following compatibility 
issues:

• 3DNV 1.5.0 cannot be used with IT Guru 11.0 PL1.

• IT Guru 11.0 PL3 cannot be used with 3DNV 1.1.0.

Also, the 3D Logger file format has been changed. This new format is more 
compact, resulting in smaller log files and faster communications with 3D 
Logger. 3D Logger 1.5.0 can still read log files created by earlier versions; 
however, any messages related to decorations and layers will not be processed 
by 3D Network Visualizer 1.5.0.

3D Network Visualizer

Joystick Support

3D Network Visualizer now supports game controllers such as joysticks, game 
pads, and spaceballs.

Support for Loading Multiple Database Types

3D Network Visualizer can load and display terrain databases in GDB, CTDB, 
and DTED formats. It can also load files using the MÄK .map format.

Range Volumes

Range volumes are translucent volumes that identify the area within which an 
entity’s armaments are effective. It is configured in 3D Network Visualizer and 
does not rely on information coming in over the network.

New and Update Configuration Parameters

3D Network Visualizer has many new parameters to support the new features. 
See the Animation Viewers Reference Manual for details. The PreloadModels 
parameter is now off (0) by default. This means that models will be loaded 
dynamically. 3D Network Visualizer might freeze while loading a large model. 
You can configure 3D Network Visualizer to load all models at startup by 
changing this parameter in params.mtl.

3D Logger

Faster Timeskip During Playback

3D Logger now supports indexing of Logger files. The new indexing features 
support faster skipping during playback, particularly for large Logger files. When 
you record a simulation with indexing enabled, 3D Logger periodically saves 
checkpoints with the complete state of the simulation. When you skip forward 
through the recording, 3D Logger moves to the nearest checkpoint prior to the 
requested skip time, then fast forwards through the recording to the requested 
time. This process is transparent to 3D Logger users; however, you must enable 
indexing for it to work. 
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If you do not enable indexing, recordings are made identically to those in 
previous versions of 3D Logger. These recordings, as well as those made with 
previous versions of 3D Logger, cannot take advantage of the faster timeskip 
feature. 

New File Format The 3D Logger file format has been changed to support 
indexing. 3D Logger 1.5.0 can play recordings made with previous versions of 
3D Logger. However, previous versions cannot play indexed recordings made 
with 3D Logger 1.5.0.

Converting Non-Indexed Recordings to Indexed Recordings If you load a 3D 
Logger recording that is not indexed, 3D Logger gives you the option of 
automatically converting it to indexed format. 

New Configuration Parameters To support the new indexing features, 3D 
Logger has the following new configuration parameters:

• enableIndexing – enables or disables indexing.

• checkpointFreq – specifies how often, in packets, to checkpoint the 
recording.

• autoCheckpoint – specifies whether or not to automatically convert 
non-indexed recordings to indexed format. Default: 0 (do not convert).

New Configuration Options in the Configuration Dialog Box The Configuration 
dialog box now has options to enable and disable indexing and to set the 
checkpoint frequency.

NetDoctor Enhancements

NetDoctor Concise Web Pages

NetDoctor web reports now include options for specifying the concise or 
detailed version of a rule’s output. To view a different version of the rule, select 
the Concise or Detail button in the navigation frame or content frame. Clicking 
the button in the content frame results in subsequent rule selections displaying 
in the chosen manner. Clicking the button in the content frame results in the 
selected view for that particular rule.

NetDoctor Rules

Rule Library

The following rule suites have been significantly enhanced over previous 
releases:

• NAT

• Organizational Policies
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Rule Development

If you create or edit a summary rule that uses groups, you can select the Filter 
on Selected Objects checkbox. If this box is selected, NetDoctor calls the filter 
handler only if the Report on selected objects checkbox is selected on the 
Settings tab of the Configure/Run NetDoctor dialog box.

Model Assistant File Changes

You can now save link delay as part of a model assistant file. Select 
Topology > Model Assistant > Save Current Topology to File. Observe the new 
Delay checkbox on the Link Information tab, shown in Figure 11.0-1.

Figure 11.0-1   Saving Link Delay in Model Assistant File

Flow Analysis Enhancements

Protocol Support

The 30-speaker limit on BGP with flow analysis has been changed to apply only 
to iBGP speakers. This change makes it possible to have an unlimited number 
of eBGP speakers.

Terrain Modeling Model Enhancement

Pathloss Cache Granularity

TMM now lets you adjust the granularity with which path loss calculations are 
cached during a simulation. This lets you take advantage of higher-resolution 
terrain data (by matching the granularity to the resolution of the terrain data 
being used) at the expense of using more memory. See TMM Cache on 
page TMM-2-5 of the TMM User Guide for details.

Check to save link 
delay as part of model 
assistant file.
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Discrete Event Simulation

Memory-Related Preferences

The following preferences have been added:

• memstat_autogen — specifies how often a simulation will generate memory 
statistics.

• memtag_all — specifies whether the simulation should tag memory 
allocations for memory source tracing.

• memtag_list — specifies a list of memory categories for which the simulation 
should tag memory allocations for memory source tracing.

PL0 and PL1 Changes

The following sections describe changes to IT Guru that were introduced in 
release 11.0 PL0 and PL1.

New Module: 3D Network Visualization

The 3D Network Visualizer (3DNV) module enables you to visualize your 
network model in a three-dimensional environment. The 3D Network Visualizer 
provides a view of objects and their wireless and wireline communications in the 
context of their changing positions in the 3D environment. You can generate 3D 
animations from the Project Editor or from a discrete event simulation. When 
you view communication effects in the three-dimensional context of terrain, 3D 
visualization lets you see the big picture of your mobile network.

For more information, see the Chapter 4 Introduction to 3DNV on page AV-4-1 
of the Animation Viewers Reference Manual.

New Module: 3D Logger

The 3D Logger is an add-on module that enables you to record and play back 
3DNV animations. The 3D Logger module includes the following:

• 3D Logger, a data-recorder/player that you can control through a VCR-style 
graphical user interface, a text interface, a remote control interface, or 
programmatically.

• A set of 3D Logger tools that let you combine, modify, and inspect recorded 
Logger files. You can merge the activity from several exercises into a single 
Logger file, extract a portion of a recording to a new file, and perform other 
file operations.

• A User’s Guide and online help
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For more information, see Chapter 19 Introduction to the OPNET 3D Logger on 
page AV-19-1 of the Animation Viewers Reference Manual.

ACE Whiteboard

The ACE Whiteboard enables you to edit ACE task files and to create 
application models from scratch. You can use the resulting application models 
to do predictive studies using discrete event simulations or QuickPredict. The 
ACE Whiteboard includes the following features: 

• A graphical interface for viewing and editing applications. The ACE 
Whiteboard has a user interface similar to ACE, with tabbed pages that show 
a Data Exchange Chart, a Tier Pair Circle, and a Treeview.

• Support for Python scripting to describe application characteristics and 
behaviors in detail.

• A wizard to guide you through the process of creating a new application.

• A spreadsheet-like interface for editing application messages in detail.

For more information, see Chapter 18 ACE Whiteboard—Overview on 
page ACE-18-1 of the ACE User Guide.

Early users of the ACE Whiteboard scripting API should note the following 
changes in PL1:

• The Application Base method invoke_child_task() has two new (optional) 
arguments: task_completion_function and task_completion_data.

• The Application Base method get_nodes_by_tier() has been renamed to 
get_nodes_compatible_with_tier().

• The Application Base method goto_message() has been renamed to 
goto_action().

• The Application Base method op_dist_uniform() has been renamed to 
dist_uniform().

• A new method has been added to the Application Base class: 
set_final_response(). 

• The Message class has a new boolean property called take_over_children. 
This attribute is generally used to define the dependency relationship 
between the last message generated by a script and the first message after 
the script. For more information, see <message>.take_over_children 
Attribute on page ACE-20-48 of the ACE User Guide.
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ACE Module Enhancements

Capture Agent Security Enhancements

ACE now supports encryption for authentication to, and communication 
between, the ACE Capture Manager and capture agents. Anonymous (level 1) 
encryption is used by default. You can also specify Certificate Authentication 
(level 2) encryption, which requires that the Capture Manager and the capture 
agents have a signed certificate from a trusted party within your organization. 

Note—This feature requires updated versions of the ACE capture agents. You 
can download capture agent installers and instructions for all available platforms 
from the Support Center section of the OPNET website.

For more information, see Capture Encryption on page ACE-4-2 of the ACE 
User Guide.

Capture File Import Improvements

ACE can now merge capture files where clock skew is present (that is, when 
one clock runs at a different rate from a clock on another machine). Without 
required input from you, the ACE import engine detects and resolves clock skew 
automatically.

ACE can also import capture files with asymmetric bandwidth (for example, files 
captured in ADSL environments).

You can now select multiple files when you choose capture files in the ACE 
Import Wizard.

ACE Graph/Statistic Enhancements

Importing HP GlancePlus Server Data

You can import HP GlancePlus data from text files and graph these statistics in 
the Data Exchange Chart. The workflow for importing GlancePlus data is similar 
to that for importing Perfmon data. 

For more information, see Creating GlancePlus Statistic Files on 
page ACE-11-10 of the ACE User Guide.

Importing Performance Data from OPNET Panorama

You can collect statistics directly from OPNET Panorama as part of the 
traffic-capture process. In Panorama, a correlation view specifies a customized 
set of statistics for which you want to display data. When a capture operation 
finishes, the ACE Capture Manager can retrieve data from Panorama based on 
the capture time window and a correlation view. 
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For more information, see Collecting Performance Data from OPNET 
Panorama on page ACE-4-32 of the ACE User Guide.

“Packet Delay” Statistic

The Graph Statistics window (Graph > Graph Statistics) now includes a “Packet 
Delay” statistic that shows per-packet latency between two tiers. This statistic is 
only available if the ACE file was generated from multiple capture files. 

Reporting Enhancements 

Sending Reports to Report Server

ACE can now forward the following types of reports to the OPNET Report 
Server:

• ACE Web reports

• ACE MS Word reports

• ACE Multiple Transaction MS Word reports

Miscellaneous Enhancements

The Protocol Decode Viewer window is now split into two panes: one pane for 
packets and one pane for decodes. This makes it easier to examine the same 
protocol in different packets.

You can now save your statistic settings in the ACE Treeview window; this 
means that you can look at the same set of statistics consistently. The right pane 
of the treeview also shows tick marks for individual packets.

ACE Decode Module (ADM) Enhancements

Updated Decode Engine

The decode engine has been updated to the latest Network General release, 
with improved decodes and support for additional protocols.

CORBA Tabbed Page in AppDoctor

If an ACE file contains CORBA traffic, the AppDoctor window incudes a CORBA 
tabbed page with summary and statistic information. There are multiple 
summary tables available on this page, so you can view the top CORBA 
operations based on a specific threshold (such as frequency or response time). 

For more information, see CORBA Transaction Analysis on page ACE-13-11 of 
the ACE User Guide.
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Web Services Decodes and Transaction Analysis

You can view AppDoctor statistics and transaction information for .Net, SOAP, 
and UDDI traffic. You can see SOAP-specific information in the ACE Treeview 
window, in AppDoctor, and in the Protocol Decodes Viewer.

For more information, see Web Services and Transaction Analysis on 
page ACE-13-12 of the ACE User Guide.

ACE QuickView Enhancements

Quickview now includes a graph that shows the network throughput recorded in 
the capture file. This makes it easier to filter traffic and see what you have 
captured.

Automation Module Enhancements

Username/Password Support for Automated Logins

In this release, you can specify username and password information for an 
automation task. The Automation module uses this information to log on to the 
host computer. This information might be required if the automation task needs 
to access advanced system resources such as mapped network drives.

Note—This feature is available on Windows systems only.

Scenario Web Reports

An automation task can now generate scenario web reports using the 
Scenarios > Generate Scenario Web Report menu operation. A scenario web 
report enables anyone with a web browser to to see all subnetworks, objects, 
and attributes in a scenario. 

Network Time Enhancements

In previous releases, most types of time-varying data were specified using 
relative times. For example, a traffic profile might specify traffic levels at 15 
seconds, 30 seconds, 45 seconds, and so on. Relative times are offsets from 
time 0 (that is, the start of the discrete event simulation or flow analysis). 

In this release, many types of time-varying data are specified using calendar 
times instead of relative times. A calendar time is an absolute date/time 
value—for example, “13:27:42.000 May 31 2004“. 

This change affects how Guru represents and interprets time-varying data such 
as traffic levels, link loads, statistic graphs, and the locations of mobile nodes. 
This enhancement has the following effects:
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• A scenario can have a network start time, which anchors the simulation start 
to a calendar time. For example, if the network start time is 12am on May 1, 
2004, and the simulation time is one hour, the simulation models the network 
from 12am to 1am on May 1, 2004. (Previously, the simulation time window 
was 0 to <simulation_duration_in_seconds>.)

• If a scenario has no data based on calendar times, the network start time is 
0 (undefined) by default. The first time you introduce calendar times into a 
scenario—for example, by importing traffic—Guru sets the network start time 
to the earliest imported time.

• When you import traffic flows or link loads with calendar times, Guru 
preserves the calendar times. Previously, Guru discarded the calendar 
times: the import engine aligned the earliest imported time with simulation 
time 0 and calculated relative offsets for later times. 

• Discrete event simulations and Flow Analysis ignore all time-varying data 
outside the simulation time window. For example, if the scenario has traffic 
from June to July, and the network start time is in August, Guru ignores this 
traffic. 

• If the network start time is defined, Guru converts all relative times to 
calendar times using the start time. Simulation results also have calendar 
times. 

• Guru includes a Time Controller window so you can see the changes in 
time-varying results from discrete event simulations and Flow Analysis runs. 
You can also use the Time Controller to change the network start time 
manually. For more information, see Time Controller on page RN-11.0-17.

Time Controller

The Time Controller (View > Time Controller) is useful when you want to see 
how network data changes over time. Examples of time-varying data include:

• A profile attribute that specifies how a value (such as link utilization or traffic 
levels) changes over time

• An analysis panel that shows a time-varying statistic

• Visualization of link load data from link attributes, discrete event simulations, 
or Flow Analysis runs

• The movement of mobile nodes along their trajectories in a wireless network

For more information, see Time Controller on page ITU-7-23of the Guru User 
Guide.
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Point Demands

Guru now supports point demands. A point demand is a demand with a source 
or a destination, but not both. Point demands are useful for modeling demands 
with multiple endpoints, such as multicast traffic.

Traffic Import Enhancements

OptiView Console Traffic Flow Imports

You can now import traffic flows from OptiView Console by Fluke Networks, Inc. 
You can generate traffic files from OptiView Console and import the files directly 
into Guru. For more information, see Creating OptiView Console Traffic Files on 
page MVI-3-5.

Note—To import traffic flows from OptiView Console, you must have an MVI 
module license.

Link Load Import Enhancements

Direct Communication Between Guru and External Programs

In this release, Guru can use telnet and ftp to generate and retrieve data from 
external systems automatically. This capability has the following benefits:

• For Concord imports, Guru can use telnet commands to extract and 
download link-load data. This eliminates the need to interact with the external 
system manually. 

• For all link load imports from external systems, Guru can retrieve data from 
remote computers using ftp. This eliminates the need to transfer data to the 
Guru computer yourself before an import. 

User Interface Enhancements

The Import Device/Link Loads dialog box has the following enhancements:

• You can use the Add Server operation to specify a remote host and the 
information that Guru needs to retrieve data from the host. 

Source-only 
point demand
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• The Concord import operations have default telnet commands for generating 
data. However, you can specify your own telnet commands to generate data 
during an import.

• This dialog box has a Summary tabbed page that shows the number of 
selected files, time window, sampling interval, and the approximate memory 
required for the import operation. 

Link Load Imports from HPOV Performance Insight 

Guru can now import link loads from HP OpenView Performance Insight. For 
more information, see Performance Insight Link Loads: Preparing for an Import 
on page MVI-4-8 of the Multi-Vendor Import User Guide.

Note—To import link loads from Performance Insight, you must have an MVI 
module license.

Topology Import Enhancements

XML Export/Import Support for Extended Attributes

The XML topology import/export operations now support extended attributes. In 
previous releases, this information was not included in the XML export/import 
files. However, IT Guru cannot export or import the following types of extended 
attributes:

• Compound extended attributes

• Extended attributes with property restrictions

Device Configuration Import (DCI) Enhancements

New Protocol Support

• Aggregate Interface support (such as EtherChannel)

• MPLS (LDP-based VPLS, Layer-2 VPNs, bypass tunnels, Diffserv-aware 
TE)

• IP Multicast

• Voice over IP (not supported on Cisco multi-layer switches)

Security and System Management Configuration on Switches

Both security and system management commands are now supported for 
CatOS on Cisco Catalyst Layer-2 switches. Included are

• AAA—Authentication, Authorization and Accounting

• TACACS+

• Kerberos
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• RADIUS

• SNMP

• Logging

Concise Import Summary

After device configuration import, a concise import summary report is now 
displayed. This report is an abbreviated form of the detailed report, listing 
one-line summaries of signification import information. More specific details are 
available via tooltips or the View Details button, which brings up a more detailed 
summary, similar to the summary available in release 10.5.

Figure 11.0-2   Concise Import Summary

Aggregate Interface Support

In this release of IT Guru, DCI recognizes and imports aggregate interface 
configuration. The link configuration of an interface is inferred by way of the 
aggregate interface of which it is part. Support is provided for

• EtherChannel

• Link Aggregation Control Protocol (LACP)

• Multilink PPP

Static PVC Mapping 

IT Guru now reads static PVC mapping from both Frame Relay and ATM device 
configuration files. In previous releases, you had the option to create a full-mesh 
of PVCs or none at all. The imported topology will now correctly show static PVC 
mapping, when configured. Enhancements in show command support for 
device configuration import include the following:
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• Import Device Configuration Dialog—The PVC creation checkbox for device 
configuration import has changed. You can now specify import to Create 
PVCs or leave the box unselected. If the box is selected, DCI will parse PVC 
contract parameters from show commands in imported configurations.

• Frame Relay—Traffic contract parameters are set for PVCs with a static 
mapping. Information from show frame-relay map command is read and 
used to create a map of the actual PVC configuration in the topology.

• ATM—Static mapping of ATM PVCs is read from the show atm map 
command. Traffic contract parameters are set based on the static PVC 
configuration in the device.

Layer-3 Import

You can now configure DCI to import Layer-3 devices only. By setting the 
preference device_import.layer3_only_import to TRUE in 
$HOME/op_admin/env_db11.0, you restrict the import to include the following 
devices:

• Routers/Layer-3 modules (IOS/JUNOS)

• Router-Switches (Hybrid OS/Native IOS)

• PIX Firewalls 

Layer-2 devices (i.e., CatOS switches and IOS switches) will be disregarded 
during import when this preference is enabled. Connectivity for router-switches 
is inferred from the VLAN interfaces rather than from CDP information during 
import. This preference is disabled by default.

Model Assistant File Usage

A new checkbox was added that allows you to specify whether or not you want 
DCI to consider Import Assistant files during import. If the box for “Use the 
following model assistant files” is deselected, DCI will not consider any model 
assistant files specified in the area provided. If this box is selected (default), DCI 
will consider the model assistant files that you specified.
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Figure 11.0-3   Using Model Assistant Files

VNE Server Import Enhancements

New Protocols

Support for import of the following protocols was added:

• Voice over IP

• IP multicast

• Aggregate interfaces (EtherChannel, Multilink PPP, and LACP)

• Legacy protocols (IPX, RSRB, DLSw+)

• ATM-Frame Relay PVC mapping

• Security parameters on Layer-2 switches

• System management commands on Layer-2 switches

New Devices

Support for the following device types was added:

• Juniper ERX

• Checkpoint Firewall-1

WARNING—Juniper ERX devices are not supported for incremental import.

User Interface Enhancements

Significant enhancements to the user interface for VNE Server import are 
introduced in this release, including:

• the ability to specify a VNE Server hostname instead of an .ior file.

• the ability to specify an import mode, including incremental import.
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• the ability to selectively filter and import server metric data.

• the ability to include or not include model assistant files during import.

Figure 11.0-4   Import from VNE Server Dialog Box

Incremental Import

Import from VNE Server now includes support for incremental import. This 
option allows you to import just the changes in your network devices since the 
last import, rather than reimporting the entire topology. To determine changes, 
the import tool examines the timestamp of the last VNE Server import in the 
IT Guru project and imports any changes that have occurred in VNE Server 
since then.

Note—An incremental import will not take into account changes you make to 
the network model once it is imported from VNE Server. It is important to save 
a copy of your the topology immediately after an import from VNE Server and to 
use that as your baseline for the next incremental import.

Import Summary

When an import from VNE Server is complete, an import summary report now 
displays. The report contains information about the import including timestamp, 
duration of process, and information about devices that were imported.
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Import Device Configuration Source Files

You can now import the device configuration files that are collected by VNE 
Server when you import your network model from VNE Server. This feature 
allows you to view the configuration files for a node within the project in Guru. 
You can also run NetDoctor using rules that analyze the actual configuration 
files. 

You may only import the device configuration files with a fresh import (full or 
filtered) from VNE Server. It does not work with import from archive file or with 
incremental imports.

Figure 11.0-5   Include Collected Configuration Files

Must be 
imported from 
server, not 
from archive 
file. 

Must be first 
import or 
“Replace entire 
network model” 
for subsequent 
imports.

Check box to 
include 
configuration 
files in import 
from VNE 
Server.
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The files that are sent from VNE Server when the “include collected 
configuration files” option is selected are config files, “show version”, and “show 
vlan” data imported into VNE Server using the Device Configuration File Import, 
Device Version Import, and Device VLAN Database Import adapters, 
respectively. These files are typically provided by Device Configuration File 
Collection adapter but can also be copied via the Remote File Collection 
adapter as is the case with some users.)

Note—With VNE Server version 3.0.1 build 783, Ciscoworks Configuration File 
Import can also be a source for configuration files, however you MUST have 
updated model libraries for this feature to work.

Custom Attributes

You may have custom attributes configured in VNE Server. When these exist, 
they will be mapped as extended attributes during import from VNE Server. The 
attributes are available for viewing and editing through the Extended Attributes 
button on the Edit Attributes dialog box.

Link Utilizations

Link Load Visualizations

In previous versions of IT Guru, you could view link-load visualizations using 
different operations, depending on the source of the link-load data:

• View > Visualize Link Baseline Loads (link object attributes)

• DES > Color Links by Utilization (discrete event simulation results)

• Flow Analysis > Color Links by Utilization (Flow Analysis results)

These different operations have been combined into one set of operations on 
the View > Visualize Link Loads submenu. You can set visualization settings 
(line thickness and color) for all data sources in one dialog box. You can also 
animate through link visualizations using the Time Controller (described in Time 
Controller on page RN-11.0-17).

For more information, see Visualizing Link Loads on page ITU-7-28 of the Guru 
User Guide.

Link Peak Usage Reports

Link peak usage reports let you view utilization and throughput information for a 
link. Link peak usage reports show you the highest utilization attained on the link 
during a flow analysis or discrete event simulation. These reports consider the 
traffic from traffic flows, link loads, and PVCs. Application and other types of 
explicit traffic are not considered.
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New Module: Design Module

The Design Module enables you to configure and run network design actions. 
Design actions provide a very flexible way to make automated changes to your 
network.

The OPNET Model Library includes a set of standard design actions. Each 
design action combines internal design logic with a set of configurable 
attributes. You can configure a design action in the same way that you configure 
other types of objects. 

For more information, see the Design Module User Guide.

Live Report Tables

You can now view object attributes across many selected objects using a Live 
Report Table (Scenarios > User-Defined Reports > Open Live Report Table). A 
Live Report Table uses an attribute template to show the settings of related 
attributes on selected objects; the table also updates its contents when you 
change the attributes shown or select different objects. 

For more information, see User-Defined Reports on page ITU-15-13 of the Guru 
User Guide. 

Device Type and Make Network Views

This release includes a new network view that lets you replace the standard 
OPNET icons with generic icons that indicate the type and make of the device. 
For example, with this view applied, all routers share the same icon. The only 
difference from one router to the next would be the model information, which is 
also shown. This view is available from the View > Set View for 
Subnet/Network > Device Type and Make menu option.
RN-11.0-26 IT Guru/Release 11.0



Release Notes
Figure 11.0-6   Effect of Device Type and Make Network View

For more information, see User-Defined Reports on page ITU-15-13 of the Guru 
User Guide. 

Random Mobility Trajectories

You can now create trajectories based on the movements generated by a 
random mobility. A new attribute of random mobility profiles lets you turn 
trajectory creation on and off. When this feature is turned on, a trajectory will be 
created during the next simulation. You can then assign the trajectory to a node 
and reuse it in subsequent simulations.

For more information, see Creating Random Trajectories on page WM-2-24 of 
the Wireless Module User Guide.

Editing Attributes on Multiple Objects

You can now edit attributes on multiple objects in one window, using an attribute 
table similar to a User Defined Report. You can create your own attribute 
templates that specify the related attributes you want to edit. The Edit menu 
includes the following new menu items:

• Edit > Edit Attribute Template—Create and edit an attribute template; this 
template defines the object types and attributes that you can edit, as well as 
the attributes you can view in a user-defined report. This operation has the 
same functionality as the Scenarios > User-Defined Reports > 
Define Report operation in previous releases; for this reason, the latter menu 
item has been removed.

• Edit > Edit Objects Using Template—Select the attribute template you want 
to open, then view and edit the relevant attributes.

Default Network View Device Type and Make Network View
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For more information, see Using the Attribute Template Method on 
page ITU-9-9 of the Guru User Guide. 

Reporting Enhancements

User-Defined Report Changes

The new functionality for editing attributes on multiple objects has changed the 
workflow for defining user-defined reports. In previous releases, the menu 
operation to define a report was Scenarios > User-Defined Reports > 
Define Report. In this release, the menu operation is Edit > 
Edit Attribute Template.

Improved Network Difference Reports

Network Difference Reports are improved in this release. The web report now 
has an updated look and includes a navigation bar on the left. Report results 
appear as clickable objects in the body of the report, similar to other OPNET 
web reports.

Moving Nodes or Subnets to a New Parent Subnet

This release includes four new ways to move nodes or subnets from one parent 
subnet to another:

• Drag and drop from the Network Browser treeview—Select one or more 
nodes in the treeview; then drag the selection to a subnet icon in the treeview 
or the workspace. 

• Shift-drag and drop within the Project Editor workspace—Select one or more 
nodes; then hold down the Shift key and drag the selection over a subnet 
icon.

• “Move Selected Nodes into Subnet” menu option—Select one or more 
nodes; then right-click on the destination subnet and choose Move Selected 
Nodes into Subnet.

• “Move Selected Nodes to Parent Subnet” menu option—Select one or more 
nodes; then right-click in the background (not on the selected objects) and 
choose Move Selected Nodes to Parent Subnet.

All four operations move the selected nodes to the new subnet and retain all 
attached links, paths, and demands. If the positions of the relocated nodes do 
not fall within the target subnet's bounds, Guru refreshes the subnet layout to 
determine the new positions of the nodes.
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Bird’s-Eye View

You can quickly focus and adjust the zoom level of the Project Editor window 
using the Bird’s Eye View window (View > Bird’s Eye View) This window is 
especially useful for specifying a desirable zoom level quickly and for finding 
areas of interest in large or crowded networks.

For more information, see Bird’s-Eye View on page ITU-7-34 of the Guru User 
Guide.

Network Inventory Summary

You can now get a summary report of the objects in your network model 
including network devices, physical and virtual links, traffic flows, and a count of 
vendor devices. The report is exportable to various formats such as MS-Excel.

Figure 11.0-7   Network Inventory Summary

To launch this feature, you can either click on the toolbar button, as shown in , 
or you can select Scenarios > Generate Network Inventory Summary.

Figure 11.0-8   Network Inventory Summary Button
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Network Layout Enhancements

Several new operations allow you to control how network objects are displayed 
and arranged in the workspace. For more information about the following 
features, refer to Network Layout and Appearance on page ITU-7-16 of the 
Guru User Guide.

Automatic Icon Scaling and Label Placement

The Project Editor window can size node icons and move node labels 
automatically to reduce overlapping. Icons can be automatically scaled to a 
smaller size if they overlap other icons. To turn automatic icon scaling on or off, 
choose View > Layout > Automatic Icon Scaling.

If there is no space to show a node label, it can be hidden unless the node is 
selected. To turn automatic label placement on or off, choose 
View > Layout > Automatic Label Placement.

Automatic icon scaling in large networks can slow down performance. For this 
reason, autoscaling is turned off if the node count reaches or exceeds the 
threshold specified by the icon_autosizing.large_element_count preference. 
There are also two other new preferences related to this feature: 
icon_autosizing.disable and icon_autosizing.max_neighbors.

Interactive Node Layout

You can quickly adjust the layout of some or all sites in a subnet using the new 
Interactive Layout dialog box (View > Layout > Layout Nodes Interactively...). 
You can move nodes closer together or farther apart, rotate nodes around an 
axis, or disperse nodes throughout a rectangular region.

Automatic Node Layout

You can automatically reposition the sites in a subnet using either of two layout 
algorithms. Both attempt to position sites in an orderly layout. The operations 
that do this are

• View > Layout > Layout Nodes Automatically (Balanced)

• View > Layout > Layout Nodes Automatically (Simple)

The balanced algorithm produces a more elegant layout, but the simple 
algorithm is faster and uses less memory (thus is better for subnets with a large 
number of sites). A new preference, network_layout.use_simple_threshold, 
allows you to set a threshold below which the balanced algorithm is used. Above 
the threshold the simple algorithm is used. Certain topology imports, such as 
Device Configuration Import and Import from VNE Server,  use the balanced 
algorithm to position sites for small networks (fewer nodes than the threshold 
set by the network_layout.use_simple_threshold preference) and the simple 
algorithm for networks with a number of nodes greater than the set threshold.
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Annotation Enhancements

Box, ellipse, and text annotation objects have a new “rotation” attribute that 
enables you to rotate an annotation by the specified number of degrees.

Text annotations have a new “background color” attribute that enables you to 
set a background color for the text box background.

You can now create “icon annotations” from the object palette 
(Topology > Object Palette). These objects have an “icon name” attribute that 
enables you to use an icon from one of the icon databases listed in your model 
directories.

Memory Improvements

Guru now uses 40 to 60 percent less memory (RAM) to represent network 
models that contain large numbers of objects. For example, a network that used 
about 500 MB of memory in release 10.5 now uses between 200 MB and 300 
MB.

Encrypted Passwords

IT Guru now encrypts preferences that specify passwords (including Report 
Server and license-registration passwords) in the environment database file and 
the Preferences dialog box.

Note—This feature might be unavailable due to legal restrictions in your 
country. 

Connection Browser Enhancements

You can now show LSP routes calculated during an design action or Flow 
Analysis run in the Connection Browser (Topology > Connection Browser). 
Each route appears as a child of its associated LSP path object. When you 
select a route in the treeview, the route is highlighted in the network pane. 

NetDoctor Enhancements

Rule Library

New rule suites have been added in this release:

• IP multicast

• Link aggregation
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• MPLS VPNs

• Spanning tree

• Voice over IP

The following rule suites have been significantly enhanced over previous 
releases:

• AAA

• Administration

• ATM

• IP routing

• NAT

• PIX firewall

• Organizational Policies

• VLANs

Other enhancements to rule suites include

• Charts (bar and pie) added to selected summary rules

• Handling of security and system management on switches

• Handling of VRFs

• Support for auto-template creation

• Support for internationalization on selected suites

• Aggregate interface support for Layer-3 devices

• Aggregate port support for Layer-2 devices

• PIX ACL support

• Juniper firewall filter support

Automatic Template Creation

You can now have NetDoctor automatically create a template of rules. This 
method of creating templates lets you specify broad characteristics of the rules 
you want to check without having to individually build the rule set. NetDoctor 
uses this information plus an analysis of your network model to intelligently 
select rules.
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For example, if you are interested in analyzing the security configurations in 
your network, you can tell NetDoctor to choose security-related rules. NetDoctor 
then intelligently selects rules related to security that apply to your network 
model.

Reports on Selected Objects

In this release, support is included for reporting on a selected set of objects. You 
can select one or more objects in the workspace prior to running NetDoctor and 
then run the report on just that selection. In the NetDoctor dialog box, a 
checkbox on the Settings tab allows you to specify reporting on the currently 
selected objects (default) or saved object selection sets.

Figure 11.0-9   Report on Selected Objects

Language Option for Reports

NetDoctor now supports reports in languages other than English. The open 
architecture allows you to include additional languages. When creating a 
template, you can specify the language in which you wish to produce the report, 
and you can save the setting along with the template.

Note—Currently, some of NetDoctor’s older rules only support reports in 
English.

You can also specify an output language for a NetDoctor report when using the 
menu option NetDoctor > Run NetDoctor...

You can report on 
currently selected 
objects or object 
selections saved 
previously in an object 
selection set.
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Viewing Recent Reports

You can now retrieve a configurable number of reports previously generated by 
NetDoctor. In past releases, NetDoctor stored data from multiple runs, but you 
could only view the last report that was created. Now you can view previous 
reports in the output format of your choice. This feature is accessed from 
NetDoctor > View Recent NetDoctor Reports.

New Charts

Charts are now incorporated into NetDoctor reports to illustrate the results. This 
includes bar and pie charts designed to enhance the information presented. 

Customizing NetDoctor

Adding/Editing Rule Parameters

The ability to add and edit rule parameters has been enhanced. Instead of 
creating parameters with editable string values, you can now specify the values 
from which a user will select. Support has also been added to let you specify a 
number type as an integer or double rather than simply “number”. 

WARNING—If you have custom rules that contain parameters, they will not 
work in this release until you update them. For instructions, refer to the 
Customizing NetDoctor chapter in the User Guide, Editing a Rule on 
page ND-4-15. If you encounter problems or need assistance, please contact 
OPNET Technical Support.

Message Suppression Files

If you have message suppression files created using a prior release of OPNET, 
they will not work in this release. Only new suppression files, created using 
OPNET 11.0, will work.

Additional Color Choices

NetDoctor now supports four additional user-specified color options in reports. 

Internationalization

This release of NetDoctor provides an infrastructure for report generation in 
multiple languages.

Charting

NetDoctor supports charting within this release. This includes the ability to 
customize different kinds of charts within reports (e.g., bar chart, pie chart).
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API Enhancements

This release includes support for new classes, methods and functions and 
modifications to existing APIs. For example,

• The new method Port.get_technology_type() can be used to determine the 
link technology of a port. This method returns a Port_Technology_Type. 

• Report_Run.report_on_selected_objects() checks to see if the Run on 
Selected Objects check box is selected, and Node.is_selected() checks to 
see if an individual node is selected in the network model.

General Enhancements

Model Documentation

The Modulation Curve Editor (in the Wireless Module) and the PDF Editor now 
allow you to add comments that are stored with the model. This allows each 
modulation and PDF curve to have specific information about what the model 
does and how it should be used.

Discrete Event Simulation

Various enhancements have been made to discrete event simulation.

Memory Use on Windows

By default, most versions of Windows allows a process to use at most 2GB of 
memory, regardless of how much swap space is available. However, some 
versions (such as Windows Server) can be configured to allow a process to use 
up to 3GB of memory. In Guru 11.0, the following executables can use this 
additional memory space, if allowed by the OS:

• Dynamic simulations (those using op_runsim and related applications)

• All OPNET-created static executables (such as static simulations)

• EMA programs

At this time, Guru and OPNET modules are limited to 2GB of memory space. 
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Simulation Summaries

The final summary information generated by a simulation is now saved in the 
simulation log file. You can save individual log files if you need to compare 
performance across several simulations. This information is saved as a 
low-level simulation summary, with a message similar to the following:

Program: op_runsim (2834)
Kernel: development (not optimized), sequential
Events: Total (10,525), Average Speed (8,866 events/sec.)
Time: Elapsed (1.2 sec.), Simulated (1 hr. 0 min. 0 sec.)
Memory: general(3,177 kb), categorized (5,698 kb), pooled (5,753 kb)

Changes to Constant Values

The values of two constants have been changed:

• Pi is now the full precision defined for the operating system in use (UNIX or 
Windows). Prior to 11.0, this constant was limited to 7 decimal positions.

• Earth radius is now precise to the nearest meter (6378137 m). Prior to 11.0, 
this constant was specified to the nearest kilometer (6378 km). This change 
adds 137 meters to the radius, which results in longer distances along the 
surface.

The combination of these two changes can result in varying numbers of events 
between releases 10.5 and 11.0 using the same models. The longer the 
distances between points, the greater the impact (thus, for example, WANs are 
affected more than LANs). In addition, even if simulations have the same event 
counts in both releases, the individual events might be shifted (different time 
values) or reordered.

Tests have not shown any significant differences in statistics except in low-level 
statistics (such as busy duration) that are directly affected by longer propagation 
times.

Changes to Geocentric Coordinate System

The ability to use different geocentric coordinate systems has been added to 
Guru. Prior to release 11.0, Guru used a left-handed coordinate system; the 
new default is right-handed. The geocentric coordinate system being used is 
specified by the geocentric_model preference.

Preference Removed

The parallel_sim.ui_selected preference has been removed. It was made 
unnecessary by the general support for parallel simulation added in release 
10.0.
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Cosimulation Speed Control

A new op_runsim preference, realtime_ratio, lets you control the speed of a 
simulation relative to real time.

Packet Duplication in Wireless Simulations

Wireless simulations now defer the duplication of packets until after closure and 
channel match have succeeded for each potential receiver. This speeds up 
simulations by avoiding unnecessary packet duplication. A new op_runsim 
preference, radio_transmission_defer_packet_duplication, lets you return to the 
old behavior.

This change can speed up wireless simulations that have many closure or 
channel match failures by up to 33%. It has no effect for simulations in which all 
packets are delivered.

Preferences

The following preferences have been added.

• log_endsim_perf specifies that a simulation should generate a simulation log 
entry based on the final performance report.

• verbose_event_report specifies that a simulation generate a report giving 
details about event generation.

• verbose_packet_report specifies that a simulation generate a report giving 
details about packet creation.

• code_editor_prog specifies an external editor program for editing C/C++ 
source code.

The ov_date and ov_time preferences have been removed, because this 
information is now part of the network model (as part of the Network Time 
Enhancements).

Terrain Modeling Module

TIREM Support

TMM now includes an integrated TIREM propagation model with an optional 
licensed module, OPNET TIREM. TIREM provides greater precision than the 
Longley-Rice propagation model, with fewer frequency and distance limitations. 
For details, see TIREM Propagation Model on page TMM-2-4 of the TMM User 
Guide.
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Model Library Behavior Changes

OSPF

The default value of the OSPF Parameters > Processes > 
Process Parameters > Reference Bandwidth attribute has changed from 1 000 
Mbps to 100 Mbps. This change is consistent with the OSPF standard (RFC 
1850) and with the default configurations of devices from vendors such as Cisco 
and Juniper.

IP Multicast

Joining Time Default Change

The default value of the Application > Multicasting Specification > Joining Time 
attribute has changed from 10 seconds to 75 seconds.

IP Multicast Tree

Previously, the IP multicast tree switched from a shared tree to a shortest path 
tree based on the traffic load for a time period. In this release, a leaf router joins 
the shortest path tree immediately after the first packet arrives from the source.

Hybrid Simulation Efficiency Mode

The Hybrid Simulation Efficiency mode is enabled in the network by default. 
This mode speeds up simulations with background traffic. This might result in 
loss of accuracy for some simulation results, such as end-to-end delays and 
application response times.

The following efficiency techniques are used:

• “Purely Analytical” Traffic Modeling Approach

• “Always Tolerant” Queue Size Convergence

• “Averaged” Flow Mixing Mode

The individual settings for these efficiency techniques can be configured using 
the attributes in the Background Traffic Config utility object.

New Format for Routing Table Imports

DES now imports routing tables from output tables (.ot) instead of gdf files. The 
IP Routing Table Export/Import simulation attribute used to export routing tables 
to GDF and later use these tables for import. If you have been running 
simulations with this attribute set to “Import”, run the simulation with the attribute 
set to “Export” to create the import files in the new format. You can then resume 
importing the routing tables during simulations.
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MRAI Delays for BGP Routes

BGP now introduces extra delays before sending routing updates. This is due 
to a new timer, Minimum Route Advertisement Interval (MRAI). This timer can 
be configured on a per-neighbor and per-node basis. The MRAI timers might 
result in changes in convergence behavior compared to previous releases.

RTP Overhead for Voice Packets

Voice packets now incur an RTP overhead of 12 bytes. This additional overhead 
will result in an increased traffic load compared to previous releases.

EtherChannel

EtherChannel links are no longer supported. In this release, Ethernet links 
replace the old EtherChannel links. To retain the old behavior, you can 
aggregate multiple Ethernet ports or interfaces into a single port or interface. 
See Ethernet Link Aggregation on page RN-11.0-40 for more information.

Duplicate ACK Threshold for Windows

The TCP > TCP Parameters > Duplicate ACK Threshold default value has been 
modified for "Windows 2000" and "Windows XP" symbol maps. The default 
value was modified from 3 to 2, in reference to “Microsoft Windows 2000 TCP/IP 
protocols and Services Technical Reference” (Lee and Davies, pg. 316). 
According to the authors, this is the default value from TcpMaxDupAck in the 
Windows process registry. The TcpMaxDupAck entry is mapped to Duplicate 
ACK Threshold in OPNET.

Model Library Enhancements

Application

The Application model suite now supports the following features:

• RTP. The real-time protocol (RTP) is now modeled. The voice application 
now resides on top of RTP, which in turn is on top of UDP. No additional 
configuration is required to use RTP other than to collect any statistics you 
want to view. A new group, RTP, is available under node statistics to analyze 
RTP behavior. End-to-end delay and jitter statistics are available on a 
per-caller, per-callee basis. 

An API, rtp_api.h, is available for RTP in the following directory: 
<opnet_dir>/<reldir>/models/std/include

• Voice traffic flows. A new utility lets you quickly create a full or partial mesh 
of VoIP (voice over IP) traffic flows. The configuration is similar to that for IP 
flows, but includes additional configuration parameters that are specific to 
VoIP traffic. To access this feature, select the Traffic > Create Traffic Flows > 
VOIP... menu option.
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Figure 11.0-10   Creating VoIP Traffic Flows

• Application deployment visualization. You can now visualize the application 
deployments in the network from within the Application Deployment Dialog 
(ADD). You can access the ADD from the Protocols > Applications > Deploy 
Defined Applications... menu option.

BGP

The BGP model suite now supports minimum route advertisement interval 
(MRAI) timers, which are helpful for convergence studies. These timers are 
configurable on a per-node and per-neighbor basis.

Ethernet Link Aggregation

The model library now supports Ethernet link aggregation by implementing the 
Link Aggregation Control Protocol (LACP) specified in section 43 of the IEEE 
802.3-2002 standard. Cisco’s EtherChannel is a form of link aggregation. In link 
aggregation, two or more Ethernet links of the same speed that connect a pair 
of nodes are aggregated to form a link aggregation group. These groups are 
treated as a single link by MAC layer protocols such as spanning tree. LACP 
performs conversation-based load sharing among the links of the group.

This new implementation provides a more accurate modeling of link aggregation 
that is not compatible with the EtherChannel models of earlier releases.The 
EtherChannel link models used in previous releases do not work in this release. 
For projects that use the older link modes, replace the links with regular Ethernet 
links and activate LACP at the ports of those links to aggregate them. For 
instance, if there is a Gig_EthCh_2 link model in a network, replace it with two 
Gigabit Ethernet links connecting the two nodes to which the Gig_EthCh_2 link 
was connected. You can then turn on LACP on the ports of these two links by 
setting the attribute Switch Port Configuration > Port Grouping Parameters > 
Aggregation Protocol to “LACP” for both ports.
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IP

The IP model suite now includes the following features. 

• Serial links now model PPP headers. Link utilization over serial links will 
therefore increase accordingly.

• You can now use the routing tables built by flow analysis in a discrete event 
simulation. For large networks, this can reduce simulation run times. To use 
this feature, set the IP Routing Table Export/Import simulation attribute to 
“Import” and set the IP Routing Table Source to “FLAN”.

• Explicit traffic on IP flows. You can now configure IP traffic flows to generate 
explicit traffic, background (analytic) traffic, or a mixture of the two. 
Previously, IP flows generated only background traffic. This feature lets you 
quickly load a network with traffic without losing some of the detailed analysis 
options as you do with purely background traffic. You can configure the ratio 
of explicit/background traffic in the Traffic Mix attribute on the flow objects. 
Now, per-demand statistics are available after a simulation.

• Congestion area. You now have several ways to view information about 
congested areas in the network when using discrete event simulation.

— Results Viewer Table.

— Route Browser.

— Time Controller Visualization.

See Chapter 11 IP Model User Guide on page STM-11-1 of the Standard 
Models User Guide for details on using these features.

IP Multicast

The IP multicast model suite has been enhanced to make the model attributes 
more closely resemble operational device configuration parameters. As a result, 
many attributes that were only configurable on a per-node basis are now 
configurable on a per-interface basis. 

When configuring IP multicast in a network model, you no longer need the IP 
Multicast configuration object. The attributes of the configuration object now 
appear on the router and host nodes. For IP multicast projects created in earlier 
releases, the model will still read the information contained in IP Multicast 
configuration object, however, you will be unable to edit the configuration object 
settings.

The model now supports dynamically chosen rendezvous points (RPs). The 
following options are now available:

• Static RP

• Auto-RP (Cisco)

• Bootstrap
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A new type of demand is available to represent IP multicast traffic. This demand, 
ip_mcast_traffic_flow, is available on the demands object palette and is a 
source demand, which is a demand attached to a source but not to a 
destination. You can configure the destination IP address for the demand to be 
that of the multicast group. The IP multicast traffic will then be routed to all 
destinations listening to the given multicast destination address.

IPv6

The IPv6 model suite now supports the following features:

• Neighbor discovery. Neighbor discovery is now configurable on a 
per-interface basis on all router and host nodes. Two new compound 
attributes, Router Solicitation Parameters and Neighbor Cache Parameters, 
let you configure neighbor discovery parameters on nodes.

• Mobile IPv6. Mobile IPv6 provides connectivity to mobile users across IPv6 
networks. The model supports the following Mobile IPv6 features:

— Route optimization

— Mobile node (MN)—Home agent (HA) bi-directional tunneling

— Extension headers (Mobility, Routing (type 2), and Destination Option)

— IPv6 (Neighbor discovery, router advertisements, duplicate address 
detection)

OLSR

The model library now includes support for OLSR (Optimized Link State 
Routing), which is a routing protocol used in Mobile Ad Hoc Networks (MANET). 
The following protocol features are included in this model:

• MPR flooding mechanism

• Neighbor sensing mechanism

• Topology discovery/diffusion mechanism

• Multiple interface support

• IPv4 Support

• IP common table usage

For more information, see Chapter 19 OLSR Model User Guide on 
page STM-19-1 of the Model User Guide.

Wireless LAN

The Wireless LAN model suite now includes a new statistic that reports on 
status of access point connectivity for the WLAN MAC. You can find this new 
module statistic, AP Connectivity, in the WLAN statistic group.
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Flow Analysis Enhancements

Default Start Time

The default start time for a flow analysis is now the configured network start 
time. If no network start time is set, the default time is the earliest profile start 
time configured on any of the traffic flows in the network. If neither of these 
values are set, the current time is used for the default start time. This default can 
be changed, as required.

Common User Interface for ATM and IP Flow Analysis

The IP mode and ATM mode for Flow Analysis have been combined into a 
single mode. You no longer need to switch modes when changing from an ATM 
network to an IP network. Further, Flow Analysis lets you analyze networks that 
are running IP and ATM. Flow Analysis uses the IP settings to analyze the IP 
portion of the network and the ATM settings to analyze the ATM portion of the 
network.

By default, Flow Analysis is set up to run on packet-switched networks. To run 
Flow Analysis on circuit-switched networks, you need to set the 
flow_analysis_network_mode environment preference to circuit-switched.

Capacity Planning

Flow Analysis now includes a Capacity Planning feature that lets you forecast 
and analyze traffic. You can use the Capacity Planning feature to study the 
effects of future traffic patterns on a network. This operation looks for trends in 
the current traffic and creates additional future traffic based on those trends. 
Guru presents the results of the capacity planning analysis in a detailed web 
report.

The Capacity Planning feature also requires the Planning and Design (PAD) 
module. The PAD module is standard with SP Guru but optional for IT Guru. For 
more information, see Chapter 4 Using Capacity Planning on page FA-4-1 of 
the Flow Analysis User Guide.

Unconnected Interfaces

Flow Analysis now has an option that lets you include or exclude unconnected 
interfaces from the flow analysis. In earlier releases, connected and 
unconnected interfaces were included in the analysis.

Link Utilization Visualizations

The visualization and animation operation for link utilizations have moved from 
the Flow Analysis menu to the View menu. You now have several options 
besides utilization when visualizing loads on links.
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This release includes the following new link load visualization options:

• Utilization and throughput at the current network time

• Utilization and throughput at the selected reporting interval

• Peak utilization and throughput for each link

• ATM subscription for each link

Figure 11.0-11   Visualizing Link Loads

For more information, see Link Utilizations on page RN-11.0-25.

New Protocol Support

Flow Analysis now includes support for the following features:

• Link Aggregation

• IP Multicasting

• Layer-3 aggregation

• Voice over IP

• RIP offset lists 

• RIP default information

• PVPs

• Frame Relay and FRF.8

• Facility protected FRR
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Applying Changes in the Configure/Run Flow Analysis Dialog Box

The Apply button works differently from previous releases. Clicking on this 
button no longer switches you from one interval to another. Instead, the Apply 
button now saves the current configuration without opening the Flow Analysis 
Log.

OPNET Documentation Changes

New Titles

Table 11.0-1 lists new titles that have been added to the document set in this 
release.

Table 11.0-1   New Books in the IT Guru Document Set

Title Contents

Animation Viewers 
Reference Manual 1

Describes the 2-Dimensional and 3-Dimensional Animation Viewers that are available with 
various OPNET products.

1 . Replaces the Utility Programs Reference Manual that previously contained information about the 2-Dimensional Animation Viewer (op_vuanim) only.
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